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Resumen y Abstract II 

 

Resumen 

 

El Parque Natural Municipal La Correntosa contiene las fuentes hídricas que abastecen 

de agua apta para el consumo a la población urbana del municipio de Acevedo, Huila. El Parque 

está siendo impactado por actividades agropecuarias y extracción de especies maderables, lo que 

conlleva a la deforestación y expansión de la frontera agrícola. Analizar la expansión de la 

frontera agrícola en el Parque es de vital importancia para proteger los servicios ecosistémicos 

que brinda a la población del municipio de Acevedo. Por lo tanto, para la conservación del 

Parque, se implementó los sistemas de información geográfica, donde se analizó la expansión de 

la frontera agrícola en el Parque Natural Municipal La Correntosa y su área de influencia, a 

través de análisis multitemporal, usando imágenes satelitales de los años 2000, 2017 y 2023. Se 

identificó las coberturas vegetales Bosque Denso y Mosaico de Cultivos, Pastos y Espacios 

Naturales implementando la metodología Corine Land Cover adaptada para Colombia y se 

evaluó el cambio en las coberturas vegetales y su impacto en el Parque. Durante el periodo 2000-

2023 la cobertura de Bosque Denso cambió a Mosaico de Cultivos, Pastos y Espacios Naturales, 

en una extensión de 56 hectáreas. A través del análisis multitemporal se analizó que la frontera 

agrícola se expande hacia el Parque Natural Municipal La Correntosa y su área de influencia 

considerablemente, en el año 2000 el parque y su área de influencia tenían 72 hectáreas de 

territorios agrícolas y para el año 2023 se expandió a 90 hectáreas.   

 

Palabras clave: (Expansión Frontera Agrícola, áreas protegidas, análisis multitemporal).  
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Abstract 

 

The La Correntosa Municipal Natural Park contains the water sources that supply 

drinking water to the urban population of the municipality of Acevedo, Huila. The Park is being 

impacted by agricultural activities and the extraction of timber species, leading to deforestation 

and expansion of the agricultural frontier. Analyzing the expansion of the agricultural frontier in 

the Park is of vital importance to protect the ecosystem services it provides to the population of 

the municipality of Acevedo. Therefore, for the conservation of the Park, geographic information 

systems were implemented, where the expansion of the agricultural frontier in the La Correntosa 

Municipal Natural Park and its área of influence was analyzed, through multitemporal analysis, 

using satellite images from the years 2000, 2017 and 2023. Dense Forest and Mosaic vegetation 

cover of crops, pastures and natural spaces was identified by implementing the Corine Land 

Cover methodology adapted for Colombia and the change in vegetation cover and its impact on 

the Park was evaluated. During the period 2000-2023, the coverage of Dense Forest changed to 

Mosaic of Crops, Pastures and Natural Spaces, in an área of 56 hectares. Through the 

multitemporal analysis, it was analyzed that the agricultural frontier expands towards the La 

Correntosa Municipal Natural Park and its área of influence considerably, in the year 2000 the 

park and its área of influence had 72 hectares of agricultural territories and by 2023 it expanded 

to 90 hectares. 

 

Keywords: (Agricultural Frontier Expansion, protected areas, multitemporal analysis).   
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Planteamiento Del Problema De Investigación Y Su 

Justificación 

 

En la siguiente investigación se realizará un análisis de la expansión de la frontera 

agrícola en el Parque Natural Municipal (PNM) La Correntosa, área protegida del municipio de 

Acevedo Huila, a través de un análisis multitemporal usando imágenes satelitales de los años 

2000, 2017 y 2023. Esto con el fin de conservar el Parque, debido a que las áreas protegidas 

(AP) son una estrategia fundamental y esencial para reducir la pérdida de biodiversidad (Clerici 

y otros, 2020).  

 

Descripción Del Área Problemática 

 

La expansión agrícola durante los últimos años ha tenido lugar en los trópicos, ya que se 

encuentran la mayor parte de las tierras productivas sin cultivar, lo cual provoca una 

deforestación generalizada en los bosques tropicales y subtropicales (Carlsony otros 2017, 

Baumann y otros, 2022). La pérdida de bosques tropicales ha continuado en las últimas décadas 

a pesar del amplio reconocimiento de su importancia para mantener la biodiversidad (Chadid y 

otros, 2015). Colombia, país ubicado entre los trópicos tiene establecida una frontera agrícola 

que cubre el 34,7% (39.239.481 has) del territorio, sin embargo, hay 2.2 millones de hectáreas de 

actividades agrícolas en áreas protegidas, como reservas forestales y naturales; páramos y 

parques naturales (Unidad de Planificación Rural agropecuaria, 2022). La tala ilegal, y la 
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ampliación de la frontera agrícola son una de las principales causas directas de la deforestación 

en Colombia. (Instituto de Hidrologia, meterologia y Estudios Ambientales, 2021) 

 

En el municipio de Acevedo, localizado en las estribaciones de la cordillera oriental por 

el suroriente del departamento del Huila, se ubica el PNM La Correntosa, que protege la cuenca 

de la Quebrada La Correntosa, la cual abastece de agua apta para el consumo a la población del 

casco urbano del municipio. Dicho parque está siendo impactado por factores antrópicos como lo 

es la expansión de la frontera agrícola para el desarrollo de actividades agropecuarias, como la 

ganadería y cultivos, y por actividades de comercialización de madera y carbón.  

 

Lo anteriormente mencionado conlleva grandes afectaciones al Parque Natural 

Municipal, como lo es la deforestación, que además de causar perdida de hábitat y 

desplazamiento de especies, lleva a la perdida de la cobertura vegetal, y ante largas temporadas 

de lluvia remoción de masa, poniendo en riesgo la infraestructura del acueducto, 

desabastecimiento de agua apta para el consumo, afectación a cultivos y a personas aledañas a 

las cuencas del Parque Natural Municipal.  

 

Es por esto, que es de gran importancia realizar un análisis del crecimiento de la frontera 

agrícola del PNM La Correntosa y su área de influencia, a través de un análisis multitemporal 

usando imágenes satelitales de los años 2000, 2017 y 2023.  
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Formulación Del Problema 

 

 ¿Cómo analizar la expansión de la frontera agrícola en el Parque Natural Municipal La 

Correntosa, municipio de Acevedo, mediante la implementación de sistemas de información 

geográfica para la conservación del área protegida? 

 

Justificación 

 

El análisis de la expansión de la frontera agrícola en el PNM La correntosa es de vital 

importancia para proteger los servicios ecosistémicos que brinda a la población del municipio de 

Acevedo. Además, el PNM pertenece a la Reserva Forestal de la Amazonia Ley 2da de 1959 de 

tipo A, y hace parte de macizo colombiano, por lo tanto, pertenece a la reserva de la Biosfera del 

cinturón andino. 

 

Es decir, es una zona que garantiza el mantenimiento de los procesos ecológicos básicos 

necesarios para a segura la oferta de servicios ecosistémicos, relacionados principalmente con la 

regulación hídrica y climática; la asimilación de contaminantes del aire y del agua; la formación 

y protección del suelo; la protección de paisajes singulares y de patrimonio cultural; y el soporte 

a la diversidad biológica (Ministerio de Ambiente y Desarrollo Sostenible, 2013).  
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Esta investigación se realizará sin tener antecedentes sobre el análisis de la expansión de 

la frontera agrícola en el PNM la Correntosa. Por lo tanto, se generará información referente y de 

impacto para la población del municipio de Acevedo y para entidades gubernamentales, como la 

alcaldía municipal de Acevedo, Empresas Públicas de Acevedo quien maneja el acueducto 

regional ubicado en el PNM y La Corporación Autónoma del Alto Magdalena, que mediante 

planes, programas o políticas pueden tomar medidas para detener la expansión de la frontera 

agrícola y promover el manejo sostenible de tierras, uso más eficiente del suelo y de los recursos 

naturales que brindan las reservas y áreas naturales protegidas. 
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Objetivos 

 

Objetivo General 

 

Analizar la expansión de la frontera agrícola en el Parque Natural Municipal La 

Correntosa y su área de influencia, municipio de Acevedo, para la conservación del área 

protegida, a través de un análisis multitemporal, usando imágenes satelitales en el año 2000, 

2017 y 2023. 

 

Objetivos Específicos 

 

Identificar las coberturas vegetales existentes en el Parque Natural Municipal La 

Correntosa y su área de influencia en el año 2000, 2017 y 2023. 

Implementar la metodología Corine Land Cover adaptada para Colombia en las 

coberturas vegetales existentes del Parque Natural Municipal La Correntosa y su área de 

influencia en el año 2000, 2017 y 2023. 

Evaluar el cambio en las coberturas vegetales y su impacto en el Parque Natural 

Municipal La Correntosa y su área de influencia en el año 2000, 2017 y 2023.  



 

Antecedentes 

 

El Parque PMN La Correntosa y su área de influencia no cuenta con antecedentes sobre 

el análisis de la expansión de la frontera agrícola, por lo tanto, para la presente investigación se 

tiene en cuenta literatura o estudios realizados sobre la implementación de sistemas de 

información geográfica en el análisis de la expansión de la frontera agrícola en áreas protegidas 

del país u otros países y regiones tropicales. 

 

Anzoategui et al., (2023), determinan los principales cambios de las coberturas vegetales 

(periodos 1986 - 2000 - 2016) que reflejan bordes a manera de frontera agrícola, en la zona de 

páramo del Parque Regional Natural Cortadera (municipio de Siachoque, Colombia). 

Identificaron coberturas vegetales a partir de la metodología CORINE Land Cover, a escala 

1:100.000, con el procesamiento de imágenes satelitales Landsat. Encontraron coberturas 

representativas Bosque abierto alto (Baa), Herbazal denso de tierra firme no arbolado (HdTf), 

Mosaico de pastos y cultivos (Mpc), Lagunas, lagos y ciénagas naturales (LlCn) y Cuerpos de 

agua artificial (Caa). Concluyen que los cambios en la distribución porcentual de coberturas 

vegetales son generados por ampliación de la frontera agrícola, a pesar de la declaratoria en 2015 

como área protegida, denotan una clara necesidad de abordaje desde la acción participativa 

actores involucrados en el proceso de conservación, restauración y preservación del Páramo 

Cortadera. 
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Bonfanti & Sánchez, (2023), estudiaron las transformaciones tanto en el ámbito forestal 

como agropecuario que han ocurrido en el este de la provincia de Salta, Argentina, entre los años 

2000 y 2021. A través de un método cuantitativo basado en la recopilación y análisis de datos de 

imágenes satelitales, evidenciaron que durante las últimas dos décadas existió un rápido avance 

de la frontera agropecuaria para la producción agrícola y ganadera empresarial, lo que devino en 

la ocupación de territorios que, hacia fines de siglo XX, todavía eran considerados marginales.  

 

Baumann et al., (2022), realizaron el estudio métricas de frontera para una comprensión 

basada en procesos de la dinámica de la deforestación, en Chaco, Ecorregión de América del sur, 

el cual es un punto crítico de deforestación mundial por la expansión de la frontera agrícola. Los 

resultados del estudio arrojan que la expansión agrícola ha sido rampante en el Chaco, con más 

de 19,3 millones de hectáreas de bosques convertidos entre 1985 y 2020, incluido un aumento de 

la deforestación después de 2019. Y que las trayectorias de uso de la tierra conectadas con los 

procesos fronterizos han cambiado de manera importante a lo largo de los últimos años.  

 

Lonbeck et al., (2022), cuantificaron la dinámica forestal espaciotemporal en una frontera 

agrícola recientemente colonizada en el sur de México, y probaron cómo la variación temporal 

en el clima y la variación intercomunitaria en la propiedad de la tierra, la calidad de la tierra y la 

accesibilidad afectan la perturbación forestal, el rebrote y la persistencia del bosque secundario. 

Encontraron más pérdida de bosques que regeneración, lo que resultó en una disminución neta 

del 45 % de la cubierta forestal (1991–2016) en la región de estudio. Y que la cubierta forestal 

secundaria se mantuvo relativamente constante mientras que la persistencia del bosque 



Capítulo 1 15 

 

secundario aumentó, lo que sugiere que los agricultores se están alejando de la agricultura 

migratoria. La variación temporal de la perturbación se explicó por la variación anual de las 

variables climáticas y las políticas clave y las intervenciones de mercado.  

 

Gallardo Arce et al., (2022), identificaron las modificaciones en la cobertura vegetal y 

uso de suelo asociados a actividades agrícolas mediante la clasificación de uso de suelo durante 

el periodo 2000-2020, con tres imágenes satelitales Landsat procesadas con herramientas de un 

sistema de información geográfica (SIG), donde obtuvieron cinco coberturas vegetales. Los 

autores identificaron aceleradas transformaciones, sustituyendo elementos naturales por 

artificiales; dando como resultado la falta de equilibrio e integración al entorno, así como 

paisajes construidos donde se han presentado diferentes escenarios agrarios y rurales con 

drásticas transformaciones derivadas de la urbanización acelerada.  

 

Devia Acosta & Piñeros Lizarazo, (2022), realizaron el mapeo de la dinámica territorial 

de las economías extractivas en una parte de la Orinoquia colombiana considerada como la 

última frontera agrícola del país. El mapeo fue un insumo para el análisis de la especialización 

del extractivismo que considera las transformaciones recientes en las áreas de agricultura 

campesina y el crecimiento de las áreas de cultivos agroindustriales, así como las nuevas 

extensiones de monocultivos y de producción petrolera. Evidenciaron la dimensión multiescalar 

del extractivismo y la complementariedad entre la expansión petrolera y agroindustrial en la 

Orinoquia, en el departamento del Meta y en otras regiones de la escala nacional como resultado 

de la demanda internacional de commodities. 



  

16 Análisis multitemporal de la expansión de la frontera agrícola en el PNM La Correntosa Título del trabajo 

 

Siegel et al., (2021), para comprender mejor la deforestación y la expansión agrícola en 

las áreas protegidas amazónicas, combinaron modelos cuantitativos de cambio de uso de la tierra 

con análisis cualitativos del discurso en un estudio de caso del Bosque Nacional Jamanxim de 

Brasil. Donde modelaron el cambio de uso de la tierra de 2008 a 2018 y proyectaros la 

deforestación hasta 2028. Usando variables identificadas en una revisión de estudios que 

modelaron el cambio de uso de la tierra en la Amazonía (por ejemplo, variables relacionadas con 

la idoneidad agrícola y la accesibilidad económica) y de un análisis crítico del discurso que 

examinó documentos producidos por diferentes actores (por ejemplo, agencias gubernamentales 

y organizaciones de conservación sin fines de lucro) en varias escalas espaciales.  

 

Maciel et al., (2020), examinan las transformaciones del uso y la cobertura del suelo en 

Brasil, donde se están eliminando grandes extensiones de vegetación natural para dar paso a la 

producción agrícola. Por ende, realizaron el análisis de la trayectoria temporal para discutir los 

patrones de cambio de las prácticas agrícolas en los diferentes biomas del estado de Mato 

Grosso, una de las fronteras agrícolas de Brasil. Tomando imágenes clasificadas de cobertura y 

uso de suelo anuales de 2001 a 2017, el LUC Calculus se utilizó como herramienta para extraer 

información sobre trayectorias y trayectorias de cambio.  

 

Florez Yepes et al., (2017), Realizan un análisis multitemporal de una zona con 

influencia de dos sistemas productivos principalmente: la ganadería y la minería y sobre la cual 

se presentan impactos ambientales significativos. Utilizaron los SIG como principal herramienta 
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y digitalizaron fotografías aéreas de los años 1998 y 2010 y una imagen tomada de Google Earth 

del año 2015. En el análisis establecieron las variaciones en las coberturas vegetales en el 

tiempo, la influencia de los sistemas productivos sobre las áreas boscosas, las áreas que han 

tenido procesos de recuperación y otras que con el tiempo han ido desapareciendo. Como es el 

caso de la ampliación de la frontera agrícola y pecuaria que ha ocasionado la pérdida de los 

bosques, incrementando la fragmentación y contribuyendo al deterioro del paisaje, notándose 

que en los últimos años ha disminuido la producción de pastos. 

 

Devries et al., (2015), presentan un método sólido basado en datos para rastrear la 

deforestación y degradación tropical en datos de series temporales de Landsat, es el método 

Breaks For Additive Season and Trend Monitor (BFAST Monitor). Cuando se aplica este 

método a los datos de series de tiempo Landsat NDVI utilizando períodos de monitoreo 

definidos secuencialmente, se puede usar para rastrear perturbaciones forestales a pequeña escala 

anualmente, como es el caso de su aplicación en un sistema forestal afromontano en el sur de 

Etiopía. 

 

 

 

 





 

Referente normativo y legal 

 

El municipio de Acevedo y su PNM La Correntosa están ubicados en el macizo 

Colombiano, lo cual pertenecen al cinturón andino declarado por la UNESCO reserva de la 

Biosfera, y hacen parte de la Reserva Forestal de la Amazonia de tipo A y C, por lo tanto, los rige 

el CONPES 3915 que dicta los lineamientos de política y estrategias para el desarrollo regional 

sostenible del Macizo Colombiano, el 4050 que establece la política para la consolidación del 

sistema nacional de áreas protegidas y el 4021 política nacional para el control de la deforestación 

y la gestión sostenible de los bosques. 

 

UNESCO, 1979: declara la Reserva de la Biosfera Cinturón Andino, ubicada en el Macizo 

Colombiano, en la Cordillera de los Andes en el sur de Colombia. Comprende tres Parques 

Nacionales: el Parque Nacional Cueva de los Guacharos, el Parque Nacional Puracé y el Parque 

Nacional Nevado del Huila. El Parque Nacional Cueva de los Guacharos comprende formaciones 

geológicas especiales y complejas y cuevas creadas por el río Suaza.  

 

Constitución política del 1991: la carta magna colombiana, entre sus artículos 8, 58, 63, 

79, 80, 334, 336 y otros, contempla la importancia de la conservación de la diversidad biológica 

del país, además de relacionar los deberes del estado y particulares, y los derechos de las personas 

a gozar de un ambiente sano.  
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Ley 2ª de 1959: Con el objeto de conservar los recursos naturales renovables y sobre la 

economía forestal de la nación se decreta en el artículo 1° “Para el desarrollo de la economía 

forestal y protección de los suelos, las aguas y la vida silvestre, se establecen con carácter de 

"Zonas Forestales Protectoras" y "bosques de Interés General”, las zonas de reserva forestal, 

comprendidas dentro de los límites que para cada bosque nacional se fijan”, entre ellas:  

La Zona de Reserva Forestal de la Amazonía, comprendida dentro de los siguientes límites 

generales: Partiendo de Santa Rosa de Sucumbió, en la frontera con el Ecuador , rumbo Noreste 

hasta el Cerro más alto de los Picos de la fragua; de allí siguiendo una línea de 20 kilómetros al 

Oeste de la Cordillera Oriental hasta el alto de las Oseras; de allí en línea recta, por su distancia 

más corta, al río Ariari, y por éste hasta su confluencia con el rio Guayabero o el Guaviare, por el 

cual se sigue aguas abajo hasta su desembocadura en el Orinoco: luego se sigue la frontera con 

Venezuela y el Brasil hasta encontrar el río Amazonas, siguiendo la frontera Sur del país hasta el 

punto de partida. 

 

Resolución 1925 de 2013: tiene por objeto adoptar la zonificación y el ordenamiento de las 

áreas de la reserva forestal de la Amazonia, establecida en la ley 2da de 1959, en el caso del PNM 

La Correntosa aplica la zonificación de tipo A y una pequeña parte de tipo C, lo cual establecen:  

Tipo A: zonas que garantizan el mantenimiento de los procesos ecológicos básicos 

necesarios para asegurar la oferta de servicios ecosistémicos, relacionados principalmente con la 

regulación hídrica y climática; la asimilación de contaminantes del aire y del agua; la formación y 

protección del suelo; la protección de paisajes singulares y de patrimonio cultural; y el soporte a 

la diversidad biológica.  
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Tipo C: zonas que por sus características biofísicas ofrecen condiciones para el desarrollo 

de actividades productivas agroforestales, silvopastoriles y otras compatibles con los objetivos de 

la reserva forestal, que debe incorporar el componente forestal, y que no impliquen la reducción 

de las áreas de bosque natural presentes en sus diferentes estados sucesionales.  

 

Resolución 0261 de 2018: por medio de la cual se define la frontera agrícola nacional y se 

adopta la metodología para identificación general, cuyo objetivo es contribuir a la formación y 

focalización de la gestión de la política pública del sector agropecuario, pesquero y de desarrollo 

rural. Además, promover el su eficiente del suelo rural agropecuario, el ordenamiento productivo 

y social de la propiedad rural, y el fortalecimiento de la productividad y competitividad de las 

actividades agropecuarias. Asimismo, contribuir a estabilizar y disminuir la perdida de ecosistemas 

de importancia ambiental.  

 

Decreto 4145 de 2011: Crea la Unidad de Planificación de Tierras Rurales, Adecuación de 

Tierras y Usos Agropecuarios (UPRA), que tiene como objeto orientar la política de gestión del 

territorio para usos agropecuarios y entre sus funciones debe Planificar el uso eficiente del suelo 

rural, Definir criterios y diseñar instrumentos para el ordenamiento del suelo rural apto para el 

desarrollo agropecuario, que sirvan de base para la definición de políticas a ser consideradas por 

las entidades territoriales en los Planes de Ordenamiento Territorial.  

 

Decreto del PNM La Correntosa: en el año 2005 el concejo municipal del municipio de 

Acevedo declaró el Parque Natural Municipal La Correntosa, con el fin de conservar y proteger la 

cuenca de la quebrada La Correntosa, donde se ubica el Acueducto Regional que abastece el 
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municipio de Acevedo, con una extensión inicial de 271 hectáreas y que hoy es de 500 hectáreas. 

Los PNM, son una estrategia de conservación de áreas, por cuanto son una fuente generadora de 

bienes y servicios ambientales que benefician la población rural y urbana, pues estas proveen de 

agua las fuentes abastecedoras de acueductos veredales y municipales. 

 

Plan Básico de Ordenamiento Territorial (PBOT): el Municipio de Acevedo, en 

cumplimiento de lo establecido en la Ley 388 de 1997 realizó la formulación del Esquema de 

Ordenamiento Territorial, sin embargo, cumpliendo al plan de desarrollo 2016-2019 se formuló 

el Plan Básico de Ordenamiento Territorial 2016-2027 (Alcaldía de Acevedo, 2018). 

 



 

Referente teórico 

 

Para el desarrollo de este proyecto se tiene en cuenta diferentes conceptos fundamentales 

para comprender y analizar la expansión de la frontera agrícola en el PNM La Correntosa, tales 

como: 

Frontera agrícola nacional: Se define como el límite del suelo rural que separa las áreas 

donde se desarrollan las actividades agropecuarias, las áreas condicionadas y las áreas 

protegidas, las de especial importancia ecológica, y las demás áreas en las que las actividades 

agropecuarias están excluidas por mandato de la ley (Ministerio de Agricultura y Desarrollo 

Rural, 2018). En Colombia, la resolución 261 de 2018 define la frontera agrícola, estableciendo 

el 34,7% del territorio para contribuir con la seguridad jurídica para el desarrollo de la 

agricultura, mientras que el 23,1% son exclusiones legales y el 42.2% son bosques y otras 

coberturas no agropecuarias, como se evidencia en la tabla 1.  

Tabla 1 

Frontea Agrícola de Colombia 

 

Nota: Adaptada (Unidad de Planificación Rural agropecuaria, 2022) 

Categoría  Área en hectáreas    Área en porcentaje 

Frontera agrícola nacional 39,600,143 34,7% 

Bosques naturales y áreas no agropecuarias 48.036.042 42,2% 

Exclusiones legales 26.438.785 23,1% 
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De igual manera se evidencia en la tabla Tabla 2 la extensión de la frontera agrícola, 

exclusiones legales, bosques naturales y áreas no agropecuarias establecidas en el Municipio de 

Acevedo. 

Tabla 2 

Frontea Agrícola del municipio de Acevedo 

 

Nota. Adaptada (Unidad de Planificación Rural agropecuaria, 2022) 

 

Cobertura y uso del suelo: El término "cobertura de suelo" se refiere a la descripción 

del material físico en la superficie de la Tierra, diferenciándose así del término "uso de suelo", el 

cual está definido por las asignaciones derivadas de la actividad humana en un territorio. Sin 

embargo, ambos están estrechamente relacionados, razón por la que muchos proyectos combinan 

el mapeo de uso y la cobertura de suelo (Comision Nacional para el Conocimiento y Uso de la 

Biodiversidad, 2020). Los estudios relacionados con los cambios progresivos en la cobertura 

vegetal y de uso de suelo han cobrado importancia en la investigación ambiental, ya que 

permiten evaluar las tendencias espaciotemporales de procesos como la deforestación y 

degradación ambiental, provocadas por actividades humanas (Escandon Calderon y otros, 2018).  

Categoría  Área en has   Área en porcentaje 

Frontera agrícola nacional 31,600 58,6% 

Bosques naturales y áreas no agropecuarias 659 1,2% 

Exclusiones legales 21,629 40,1% 
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El IGAC (2013) define la cobertura del suelo como el aspecto morfológico y tangible de 

este, que comprende todos los elementos constitutivos del recubrimiento de la superficie 

terrestre, de origen natural o cultural, los cuales son observados y permiten ser medidos, con 

fotografías aéreas, imágenes de satélite u otros sensores remotos. Este concepto se relaciona 

íntimamente con lo que se conoce como uso de la tierra, que hace referencia a las funciones que 

se desarrollan sobre aquellas cubiertas, a las actividades realizadas por el hombre sobre ellas, de 

forma parcial o permanente, con la intención de cambiarlas o preservarlas, para obtener 

productos y beneficios; por ejemplo, la minería, la agricultura, la pesca, etc. (Suarez Parra y 

otros, 2016). 

 

Áreas protegidas: la ley 165 de 1994 la define como “área definida geográficamente que 

haya sido designada o regulada y administrada a fin de alcanzar objetivos específicos de 

conservación”, y la Unión Internacional para la Conservación de la Naturaleza – UICN, la define 

como “Un espacio geográfico claramente definido, reconocido, dedicado y gestionado, mediante 

medios legales u otros tipos de medios eficaces para conseguir la conservación a largo plazo de 

la naturaleza y de sus servicios ecosistémicos y sus valores culturales asociados” (Consejo 

Nacional de Politica Economica y Social, 2010). 

 

Categorías de áreas protegidas: según Decreto Único Reglamentario del Sector 

Ambiente y Desarrollo Sostenible 1076  (2015), las categorías de áreas protegidas que 

conforman el Sistema Nacional de Áreas Protegidas (SINAP) son: los Sistemas de Parques 

Nacional Naturales, las Reservas Forestales Protectoras, Los Parques Naturales Regionales, Los 
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Distritos de Manejo Integrado, Los distritos de Conservación de suelos, Las áreas de Recreación, 

Las áreas protegidas Privadas y las Reservas Naturales de la Sociedad Civil.  

 

Zonas de influencia: son terrenos con diferentes grados de uso del suelo, situados entre 

áreas naturales protegidas, donde es posible la continuidad biológica y social entre las mismas 

áreas protegidas y otras áreas igualmente importantes por la forma en que los habitantes se 

relacionan con la naturaleza y reproducen su vida (Valdés Perezgasga, 2014) 

 

Reserva Forestal Protectora: según el decreto 2372 de 2010, en su artículo 12. Es un 

espacio geográfico en el que los ecosistemas de bosque mantienen su función, aunque su 

estructura y composición haya sido modificada y los valores naturales asociados se ponen al 

alcance de la población humana para destinarlos a su preservación, uso sostenible, restauración, 

conocimiento y disfrute. Esta zona de propiedad pública o privada se reserva para destinarla al 

establecimiento o mantenimiento y utilización sostenible de los bosques y demás coberturas 

vegetales naturales.  

  

Parque Natural Municipal: Los PNM, son una estrategia de conservación de áreas, por 

cuanto son una fuente generadora de bienes y servicios ambientales que benefician la población 

rural y urbana. Estas proveen de agua las fuentes abastecedoras de acueductos veredales y 

municipales (Corporación Autonoma Regional del Alto Magdalena, s.f.).  
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Sistemas de Información Geográfica (SIG): Sistema que crea, administra, analiza y 

mapea todo tipo de datos. SIG conecta datos a un mapa, integrando datos de ubicación con todo 

tipo de información descriptiva. Los sistemas de información geográfica y la teledetección se han 

convertido en las últimas décadas en una herramienta que conjuga varios elementos tecnológicos 

que permiten obtener productos con un nivel de detalle alto y resultados óptimos que facilitan la 

toma de decisiones respecto a procesos de planificación y desarrollo, en muchos casos enfocados 

a la agricultura, conservación, meteorología, la ordenación del territorio o la elaboración de 

cartografía entre otros (Grande Medina, 2015). 

 

Imágenes satelitales: Una imagen satelital es una representación visual de los datos, 

reflejados por la superficie de la tierra que captura un sensor montado en un satélite artificial. 

Los datos son enviados a una estación terrena en donde se procesan y se convierten en imágenes, 

enriqueciendo los conocimientos de las características de la Tierra en diferentes escalas 

espaciales (Instituto Nacional de Estadística y Geografía [INEGI] s.f). 

 

Landsat: es uno de los programas de imágenes de satélite más antiguos. Sus datos de alta 

calidad abarcan muchos rangos de longitud de onda del espectro electromagnético y realzan 

entidades que, de lo contrario, serían invisibles al ojo humano, cada rango se almacena por 

separado en una banda espectral y resulta especialmente útil para resaltar un tipo de entidad o 

propiedad de paisaje (Esri, 2023). En la tabla 3 se observan los diferentes satélites landsat, 

sensores y las resoluciones espectrales, espaciales, radiométricas y temporales. 

Tabla 3. 
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Información Sensores Landsat 

Satélite y Sensor Resolución espectral y espacial Resolución 

radiométrica y 

temporal 

Landsat 5 

 

Sensor  

Tematic mapper 

TM 

Banda 1 Visible Azul (0.45 – 0.52 µm) -30m 

Banda 2 Visible Verde (0.52 – 0.60 µm) -30m 

Banda 3 Visible Roja (0.63 – 0.69 µm) -30m 

Banda 4 Infrarrojo cercano (0.76 – 0.90 µm) -30m  

Banda 5 Infrarrojos onda corta (1.55 – 1.75µm) -30m 

Banda 6 Infrarrojo térmica (10.4 – 12.5 µm) -120m  

Banda 7 Infrarrojo medio (2.08 – 2.35 µm)-30m 

8 bits 

 

18 días 

Landsat 7 

 

Sensor  

enhancedThemati

cPlus ETM+  

 

Banda 1 visible Azul (0.45 – 0.52 µm) -30m 

Banda 2 visible Verde (0.53 – 0.61 µm) -30m 

Banda 3 visible Roja (0.63 – 0.69 µm) -30m 

Banda 4 Infrarrojo cercano (0.78 – 0.90 µm) -60m  

Banda 5 Infrarrojos onda corta (1.55 – 1.75µm)-60m 

Banda 6 Infrarrojo térmica (10.4 – 12.5 µm) -60m  

Banda 7 Infrarrojo medio (2.08 – 2.35 µm)-60m 

Banda 8 Pancromático (0.52 – 0.90 µm) -15m 

8 bits 

 

16 días 

Landsat 8 

 

Sensor  

Operational Land 

Imager OLI  

 

Thermal Infared 

sensor 

TIRS 

Banda 1 Aerosol costero (0.43 – 0.45 µm)-30m 

Banda 2 Azul (0.45 – 0.51 µm) -30m 

Banda 3 Verde (0.53 – 0.59 µm) -30m 

Banda 4 Roja (0.64 – 0.67 µm) -30m 

Banda 5 infrarrojo cercano (0.85 – 0.88 µm) -30m  

Banda 6 SWIR 1 (1.57 – 1.65 µm) -30m 

Banda 7 SWIR 2 (2.11 – 2.29 µm) -30m  

Banda 8 Pancromático (0.50 – 0.68 µm) -15m 

Banda 9 Cirrus (1.36 – 1.38 µm) -30m 

Banda 10 TIRS (10.6 – 11.2 µm) -100m 

Banda 11 TIRS (11.5 – 12.5 µm)-100m 

12 bits 

 

16 días 

Landsat 9 

 

Sensor  

Operational Land 

Imager 2 OLI-2 

 

Thermal Infared 

sensor 2 

TIRS-2 

Banda 1 visible (0.43 – 0.45 µm)-30m 

Banda 2 visible (0.45 – 0.51 µm) -30m 

Banda 3 visible (0.53 – 0.59 µm) -30m 

Banda 4 Roja (0.64 – 0.67 µm) -30m 

Banda 5 infrarrojo cercano (0.85 – 0.88 µm) -30m  

Banda 6 SWIR 1 (1.57 – 1.65 µm) -30m 

Banda 7 SWIR 2 (2.11 – 2.29 µm) -30m  

Banda 8 Pancromático (0.50 – 0.68 µm) -15m 

Banda 9 Cirrus (1.36 – 1.38 µm) -30m 

Banda 10 TIRS (10.6 – 11.2 µm) -100m 

Banda 11 TIRS (11.5 – 12.5 µm)-100m 

14 bits 

 

8 dias 

Nota: adaptado página ESRI  
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Sentinel: la Agencia Espacial Europea desarrolló la familia de satélites Sentinel, cuyas 

misiones están respaldadas por el segmento terrestre de Copernicus, que supervisa las 

operaciones de los satélites, así como la adquisición, producción y difusión de datos (Agencia 

Espacial Europera, 2024). En la tabla 4 se observan los diferentes satélites sentinel, sus sensores 

y las resoluciones espectrales, espaciales, radiométricas y temporales. 

Tabla 4. 

Información Sensores Sentinel 

satélite y Sensor Resolución espectral y espacial Resolución 

radiométrica 

y temporal 

Sentinel 1  

(Sentinel 1A y 1B) 

 

Radar de Apertura Sintética 

(SAR) 

Banda C-10m 

Banda L-10m 

Banda X-5m 

  

12 bits 

 

6 días 

Sentinel 2  

(Sentinel 2A y 2B)  

 

Multispectral Instrument 

(MSI) 

 

Banda 1: Aerosol (0.43- 0.45 μm) – 60 m 

Banda 2: Blue (0.45- 0.52 μm) – 10 m 

Banda 3: Green (0.54-0.57 μm) - 10 m 

Banda 4: Red (0.65-0.68 μm) - 10 m 

Banda 5: Red Edge 1 (0.69-0.71 μm) - 20 m 

Banda 6: Red Edge 2 (0.73-0.74 μm) - 20 m 

Banda 7: Red Edge 3 (0.77-0.79 μm) - 20 m 

Banda 8: NIR 1 (0.78-0.90 μm) - 10 m 

Banda 8A: NIR 2 (0.85-0.87 μm) - 20 m 

Band 9: Water Vapour (0.93-0.95μm)-60 m 

Banda 10: Cirrus (1.36-1.39 μm) - 60 m 

Banda 11: Swir 1 (1.56-1.65 μm) - 20 m 

Banda 12: Swir 2 (2.10-2.28 μm) - 20 m 

12-16 bits 

 

5-10 días 

 

Nota: adaptada página Copernicus 

 

 

Planet Scope: la Agencia Espacial Europea ofrece para la investigación científica y el 

desarrollo de aplicaciones, acceso a los datos del archivo completo de las misiones Planet Scope 
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tras la presentación y aceptación de una propuesta de proyecto. Estas colecciones están 

disponibles como parte de la oferta de imágenes de Planet (Agencia Espacial Europea, 2024). La 

constelación completa Planet Scope de aproximadamente 130 satélites es capaz de tomar 

imágenes de toda la superficie terrestre de la Tierra todos los días. En la tabla 5 se observan los 

diferentes satélites sentinel, sus sensores y las resoluciones espectrales, espaciales, radiométricas 

y temporales. 

Tabla 5. 

Información sensores Planet Scope 

Satélite y Sensor Resolución espectral y espacial Resolución 

radiométrica y 

temporal  

Planet Scope 

 

Dove 

PS2 

 

Banda 1: Azul: (0.45 – 0.51 µm) – 3m 

Banda 2: Verde: (0.50 – 0.59 µm) – 3m 

Banda 3: Rojo: (0.59 – 0.67 nm) – 3m 

Bando 4: NIR: (0.78 – 0.86 µm) – 3m 

 

12 bits 

 

1 día 

Planet Scope 

 

Dove-R 

PS2.SD 

 

Banda 1: Azul: (0.46 – 0.51 µm) – 3m 

Banda 2: Verde: (0.54 – 0.58 µm) – 3m 

Banda 3: Rojo: (0.65 – 0.68 nm) – 3m 

Bando 4: NIR: (0.84 – 0.88 µm) – 3m 

12 bits 

 

1 día 

Planet Scope 

 

SuperDove  

PSB.SD 

 

Banda 1: Azul costero (0.43 – 0.45 µm) – 3m 

Banda 2: Azul: (0.46 – 0.51 µm) – 3m 

Banda 3: Verde I: (0.51 – 0.54 µm) – 3m  

Banda 4: Verde: (0.54 – 0.58 µm) – 3m 

Banda 5: Amarillo: (0.60 - 0.62 µm) – 3m 

Banda 6: Rojo: (0.65 – 0.68 nm) – 3m 

Banda 7: Borde rojo: (0.69 – 0.71 µm) – 3m 

Bando 8: NIR: (0.84 – 0.88 µm) – 3m 

12 bits 

 

1 día 

 

Nota: adaptada página Planet Scope 

 



Capítulo 5 31 

 

Sensores Remotos: son Instrumentos utilizados para recolectar información rápida y 

viable de un objeto, área o fenómeno a distancia. Dicha información puede ser procesada e 

interpretada mediante el uso de Sistemas de Información Geográfica (SIG) para tener una mejor 

comprensión. Los sensores remotos instalados a bordo de una plataforma son los más utilizados 

en los últimos años, y registran la energía electromagnética emitida o reflejada por la superficie 

de un objeto en distintas bandas del espectro electromagnético (Veneros y otros, 2020).  

 

Resolución Espectral: Capacidad para detectar diferentes longitudes de onda o bandas 

espectrales en el espectro electromagnético. Indica el número y el ancho de las bandas 

espectrales que puede detectar un sensor, entre más bandas y menos estrechas mejor será el 

sensor.  

 

Resolución Espacial: la cual distingue el objeto más pequeño sobre una imagen, se 

refiere al tamaño de la mínima unidad del píxel, a menor tamaño de pixel se aumenta la 

probabilidad de identificar con mayor detalle un objeto.  

 

Resolución Radiométrica: indica la sensibilidad del sensor, es decir la capacidad de 

discriminar entre pequeñas variaciones en la radiación que capta, se refiere a la cantidad de 

niveles de gris en los que se divide la radiación recibida para su almacenamiento y 

procesamiento posterior. Cuanto mayor sea la precisión radiométrica mayor número de detalles 

podrán captarse en la imagen. 
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Resolución Temporal: indica el tiempo del paso del satélite sobre la vertical de un 

punto, está condicionada por el tipo de órbita, el ángulo de barrido y la velocidad del satélite. 

 

Metodología de Corine land cover (MCLC): es una metodología francesa adaptada por 

el Instituto Geográfico Agustín Codazzi (IGAC) y el Instituto de Hidrología, Meteorología y 

Estudios Ambientales (IDEAM) para Colombia; consiste en la evaluación de coberturas de la 

tierra mediante el uso de imágenes satelitales tipo Landsat (Suarez Parra y otros, 2016). El 

requisito básico para implementar el programa es la existencia de cambios espectrales, que son 

detectados mediante el uso de sensores remotos; estos cambios son visiblemente percibidos en la 

comparación de dos imágenes tomadas en diferentes periodos de tiempo, y los resultados se 

presentan en forma de polígonos, líneas o puntos. Estos resultados toman alta importancia 

científica, ambiental y política como base para el ordenamiento territorial, orientado a la toma de 

decisiones, la formulación de políticas de protección y conservación de los recursos naturales 

(Feranec et al. 2007), (Alva y León 2014), (Suarez Parra y otros, 2016). 

 

Territorios agrícolas: Según la MCLC son los terrenos dedicados principalmente a la 

producción de alimentos, fibras y otras materias primas industriales, ya sea que se encuentren 

con cultivos, con pastos, en rotación y en descanso o barbecho. Comprende las áreas dedicadas a 

cultivos permanentes, transitorios, áreas de pastos y las zonas agrícolas heterogéneas. 
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Mosaico de Cultivos, Pastos y Espacios Naturales: Según la MCLC comprende las 

superficies del territorio ocupadas principalmente por coberturas de cultivos y pastos en 

combinación con espacios naturales, en los cuales el tamaño de las parcelas es muy pequeño 

(inferior a 25 ha) y el patrón de distribución de los lotes es demasiado intrincado para 

representarlos cartográficamente de manera individual. Los espacios naturales están conformados 

por las áreas ocupadas por relictos de bosque natural, arbustales, bosque de galería o riparios, 

vegetación secundaria o en transición, pantanos y otras áreas no intervenidas o poco transformadas, 

que debido a limitaciones de uso por sus características biofísicas permanecen en estado natural o 

casi natural. Aquí se incluye:  

Mezcla de parcelas de pastos y cultivos con intercalaciones de espacios naturales, con área 

mayores a 25 ha. Parcelas agrícolas de cultivos anuales o transitorios con área menor a 25 ha. 

Zonas pantanosas con área menor a 25 ha. Pequeños cuerpos de agua naturales con área menor a 

25 ha. Relictos de bosques con área menor a 25 ha. Bosques de galería o riparios y arbustales con 

área menor a 25 ha. Parcelas de cultivos confinados y frutales con área menor a 25 ha • 

Infraestructuras asociadas con los pastos manejados (viviendas rurales, setos, vías). 

 

Bosque Denso: según la MCLC es la obertura constituida por una comunidad vegetal 

dominada por elementos típicamente arbóreos, los cuales forman un estrato de copas (dosel) más 

o menos continuo cuya área de cobertura arbórea representa más de 70% del área total de la 

unidad, y con altura del dosel superior a cinco metros. Estas formaciones vegetales no han sido 

intervenidas o su intervención ha sido selectiva y no ha alterado su estructura original y las 

características funcionales (IGAC, 1999).  



 

Metodología 

 

Enfoque metodológico 

 

La presente investigación tiene un enfoque cuantitativo ya que se usaron variables 

que permitieron medir fenómenos como la expansión de la frontera agrícola en un PNM del 

municipio de Acevedo. 

 

Tipo de estudio 

 

Para el desarrollo de esta investigación se implementó la investigación aplicada de 

tipo correlacional, donde se relacionan los sistemas de información geográfica con el análisis 

espacial para determinar la ampliación de la frontera agrícola en el PNM La Correntosa.  

 

Procedimiento 

 

En el desarrollo de la presente investigación se realizó un proceso metodológico de 3 

fases mencionadas a continuación con una serie de actividades cada una.  

 



 

Fase 1. Identificación De Las Coberturas Vegetales Existentes En El Parque 

Municipal Natural En Los Periodos 2000, 2017 y 2023. 

 

Actividad 1: Recolección Y Análisis De Información. Se visitó entidades 

gubernamentales encargadas del manejo y conservación del PNM la correntosa, tales como, la 

alcaldía municipal; empresas públicas de Acevedo-EMPACEVEDO; la corporación autónoma 

regional del alto magdalena-CAM y el Instituto de Hidrología, Meteorología y Estudios 

Ambientales-IDEAM, para obtener información que sirvió como insumo para establecer las 

coberturas del PNM. 

 

Actividad 2: Ubicación PNM La correntosa.  El PNM La Correntosa corresponde a la 

zona rural del municipio de Acevedo, ubicado al Suroriente del Departamento del Huila, en 

dicha ubicación se analizó la expansión la frontera agrícola del municipio, la figura 1 muestra la 

ubicación geográfica a nivel nacional, departamental y municipal del PNM La Correntosa. 

Figura 1.  

Localización área de estudio 
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El PNM La Correntosa se ubica en las veredas Recreo, San José De Llanitos, San José de 

las minas y Bolívar, veredas que se encuentran en las estribaciones de la cordillera oriental. 

Debido a esta ubicación el PNM presenta una altura máxima de 2.200 msnm donde se ubica el 

cerro la Correntosa y nace la Quebrada la correntosa, por el cual se le atribuye el nombre al 

PNM. Según CAM (2010) las veredas que conforman el PNM presentan precipitaciones de clima 

muy húmedo que oscilan entre los 2000 y 4000 mm y según el Plan Básico de Ordenamiento 

Territorial (2016) las máximas precipitaciones en el municipio ocurren de abril, mayo y junio y 

de septiembre, octubre y noviembre y la época de escasa precipitación durante los meses de 

enero y de junio a agosto. Dichos factores climáticos se tuvieron en cuenta para la búsqueda y 

selección de las imágenes. 



 

Una vez identificada el PNM se creó un área de influencia de 500 metros con la 

herramienta Pairwise Buffer la cual se menciona a continuación su ruta de acceso. 

• Analysis → tool → Toolboxes → Analysis Tools → Pairwise Overlay → Pairwise 

Buffer 

En este caso, se decidió realizar un área de influencia de 500 metros proporcional al área 

del PNM, sin embargo, según Domínguez Cervantes, 2009, para delimitar un área de influencia 

se tiene en cuenta los límites de los municipios y cuencas, los límites físico-bióticos y antrópicos 

y la caracterización social. Lo cual se requiere un trabajo con equipo técnico y tecnológico para 

definir dichas zonas.  

 

Actividad 3. Búsqueda Y Descarga De Imágenes Satelitales. Se realizó la búsqueda de 

las imágenes satelitales en diferentes portales, tales como, el portal Earth Explorer del Servicio 

Geológico de los Estados Unidos (USGS); Planet Scope y Copernicus Browser de la Agencia 

Espacial Europea (ESA). Esto con el fin de encontrar las imágenes con menor porcentaje de 

nubosidad en tres temporalidades, ya que el parque por su ubicación geográfica presenta un 

clima con bastante precipitaciones y nubosidad. En la figura 2. Se observan los diferentes 

portales usados, cabe resaltar que se realizó la respectiva creación de usuarios, para acceder a las 

diferentes imágenes satelitales. 

Figura 2.  

Portal de Earth Explore, Planet Scope y Copernicus Browser. 
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Nota: tomado de la página web del USGS y la ESA. 

La temporalidad para realizar el análisis multitemporal se definió bajo dos criterios: 

primero, la menor nubosidad en el área de estudio; y dos, la primer temporalidad debía ser o 

estar cerca al año 2005, ya que en este año se declaró el área como PNM, esto con el fin de 

observar sus coberturas antes de ser área protegida, la siguiente temporalidad debía ser o estar 

cerca al año 2015, ya que en este año se amplió el área de PNM y la última temporalidad debía 

ser del año actual 2024 para observar sus coberturas actualmente. 

 

Actividad 4. Procesamiento Digital De Las Imágenes Satelitales. Debido a que el área 

de estudio se encuentra contenido en una parte de la escena de las imágenes satelitales no se hace 

necesario la corrección por corrimiento entre empalmes por el uso de otras imágenes para crear 

mosaico y análisis de esta. De igual  manera no se hace necesario realizar preprocesamiento de 

las imágenes, ya que el USGS y la ESA realizan un procesamiento inicial de los datos crudos 

para corregir las distorsiones radiométricas y geométricas de las imágenes, por lo tanto, en la 

búsqueda de las imágenes se seleccionaron en la modalidad collection 2 level-2 en el caso de 

landsat 7, level L2A en el caso de Sentinel 2 y level 3B en el caso de Planet Scope, las cuales  ya 

tienen las correcciones Atmosféricas como reflectancia en la superficie. 



 

Actividad 4.1 Reproyección de Coordenadas Y Recorte Área De Estudio. Una vez 

descargadas las imágenes, se suben las imágenes multiespectrales al software de ArcGIS Pro 

para realizar el respectivo procesamiento de cada imagen. En la figura 3 se visualiza las 

herramientas utilizadas para los respectivos procesos. En primer lugar, se realizó la 

Reproyección del sistema de coordenadas de las imágenes en WGS 84 al Sistema de 

Coordenadas utilizado para Colombia Origen Nacional CTM12, mediante la herramienta Project 

Ráster, la cual se nombra a continuación su ruta de acceso. 

• Analysis → tool → Toolboxes → Data Management Tools → Projections and 

Transformations → Raster → Project raster 

En segundo lugar, se realizó el recorte de las imágenes con el polígono área de estudio ya 

que en el caso de las imágenes Landsat y sentinel abarcan un gran número de hectáreas de 

cobertura, lo que significa que el tamaño del archivo sea muy pesado. La herramienta para dicha 

actividad fue Extract by Mask, la cual se nombra a continuación su ruta de acceso. 

• Analysis → tool → Toolboxes → Spatial Analysis Tools → Extraction → Extract by 

Mask 

Figura 3. 

Project raster y Extract By mask   
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Actividad 4.2 Realces De Las Imágenes. Debido a que el área de estudio se encuentra en 

una zona boscosa se hace difícil identificar las diferentes coberturas, por lo tanto, para visualizar 

las coberturas se realizaron diferentes realces. En la figura 4 se visualizan las herramientas 

utilizadas en cada realce. 

 

Actividad 4.2.1 Combinaciones De Bandas. Las imágenes multiespectrales de alta 

resolución como el caso de Sentinel 2 y Planet Scope tienen como insumo solo las bandas Blue, 

Green, Red  y Near Infraeed Reflectance (NIR), por lo tanto, se realizó la combinación en falso 

color infrarrojo (NIR+Red+Green) ya que la banda infrarrojo cercano es de gran utilidad para 

identificar las variaciones de la vegetación por la gama de colores que van desde el color rojo 

oscuro que identifica bosque hasta el rosado pálido que identifica cultivos, pastos y suelos 

desnudos (Esri, 2023).  De igual manera se realizó la combinación de bandas en color natural 

(Red+Green+Blue) ya que se aproxima a los colores reales y de esta manera confirmar las 

coberturas que se identifican en la combinación de falso color. 

 

Actividad 4.2.2 Análisis De Componentes Principales (PCA). Se realizó el análisis de 

componentes principales a cada imagen multiespectral, para identificar posibles variables que no 

habían sido observadas antes y que están generando variabilidad en los datos, esta técnica 

permite que las variables originales puedan ser transformadas de un sistema correlacionado de 

datos, a uno que contiene variables que no guardan correlación entre sí y que permite una mejor 

interpretación de los datos (Ramos Organillo, 2020). a continuación, se nombra su ruta de 

acceso: 



 

• Analysis → tool → Toolboxes → Spatial Analysis Tools → Multivariate → 

Principal components 

 

Actividad 4.2.3 Índice de Vegetación De Diferencia Normalizada (NDVI). Se le calculó 

a cada imagen multiespectral el índice NDVI, este se basa en la comparación de la cantidad de 

luz reflejada en el visible rojo y el infrarrojo cercano (Olivares & Lopez Beltran, 2019). A 

continuación, se nombra su ruta de acceso:  

• Imagery → Raster Functions → Analysis → NDVI 

Figura 4. 

Herramienta Principal Components e Índice NDVI  

 

 

Actividad 4.3 Clasificación No Supervisada. El primer método seleccionado para 

realizar la clasificación de las coberturas vegetales existentes es el método de clasificación no 

supervisada “aprendizaje no supervisado o técnicas de agrupamiento (clustering)”,  debido a que 

no existe conocimiento previo del área de estudio y de los tipos de coberturas, pues esta 

clasificación se aplica con no hay conocimiento previo (Macedo Cruz y otros, 2010), en la figura 
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5 se observa la herramienta Iso Cluster Unsupervised Classification y a continuación se nombra 

la ruta de acceso. 

• Analysis → tool → Toolboxes → Spatial Analysis Tools → Multivariate → Iso 

Cluster Unsupervised Classification 

Figura 5. 

Herramienta Iso Clúster Unsupervised Classification 

 

 

Actividad 4.4 Clasificación Supervisada. La clasificación supervisada y no supervisada 

permite explorar diferentes tipos de atributos o clases por medio del análisis estadístico 

multivariado, este proceso identifica los valores de cada píxel de una o varias bandas de una 

imagen Ráster, crea y evalúa las clases, finalmente reclasifica de acuerdo con las probabilidades 

de cada clase (ESRI, 2024). En la figura 6 se observar las herramientas utilizadas para realizar la 

clasificación supervisada. 

 

Actividada 4.4 .1 Muestras De Entrenamiento Y Firmas Espectrales. Se realizó las 

muestras de entrenamiento con la herramienta Create Feacture Class con geometría de puntos, 



 

una vez establecido el muestreo de las clases identificadas, se procedió a crear las firmas 

espectrales con la herramienta Create Signature, este es un proceso que agrupa los pixeles en un 

número finito de clases individuales, con base en los niveles digitales de la imagen satelital, para 

identificar los diferentes tipos de coberturas (ESRI, 2024). A continuación, se nombra la ruta de 

acceso.  

• Edit → Features → Create  

• Analysis → tool → Toolboxes → Spatial Analysis Tools → Multivariate → Create 

Signatures 

 

Actividad 4.4.2 Maxima Probabilidad. Para la clasificación final de las coberturas se 

eligió el método de máxima probabilidad, el cual asume que los datos siguen una función de 

distribución normal para asignar la probabilidad de que un píxel cualquiera pertenezca a cada 

una de las clases. El píxel se asigna de este modo a la clase a la que es más probable que 

pertenezca (ESRI, 2024). A continuación, se nombra la ruta de acceso.  

• Analysis → tool → Toolboxes → Spatial Analysis Tools → Multivariate → 

Maximum Likelihood Classification 

 

Actividad 4.4.3 Filtro Mayoría. Se aplicó la herramienta Majoryty Filter para corregir 

errores de ruido como el efecto sal y pimienta, la herramienta remplaza las celdas en el valor 

mayoritario de las vecindades contigua, a continuación, se nombra la ruta de acceso. 

• Analysis → tool → Toolboxes → Spatial Analysis Tools → Generalization → 

Majority Filter 
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Figura 6. 

Herramientas utilizadas para la clasificación supervisada 

 

 

Actividad 4.5 Control De Calidad. Se verificó los ráster resultante de la clasificación 

supervisada con respecto a la imagen multiespectral que se utilizó para crear las firmas 

espectrales. Este control consiste en cargar las dos imágenes en un mismo espacio de trabajo, 

comparando que los tipos de cobertura resultantes correspondan con la imagen multiespectral. 

 

Actividad 4.6 Evaluación Y Validación De La Clasificación Supervisada. Se realizó la 

validación de las clasificaciones supervisadas mediante los puntos de evaluación de precisión 

que se crearon con la herramienta “Create Accuracy Assessment Points”, una vez ejecutados se 

crea la matriz de confusión con la herramienta “Compute Consusion Matrix” la cual es basada en 

errores de omisión y comisión de la clasificación supervisada y las muestras de entrenamiento 

(ESRI, 2024), en la figura 7 se observa las herramientas mencionadas y a continuación se 

nombra las rutas de acceso a cada herramienta. 



 

• Analysis → tool → Toolboxes → Spatial Analysis Tools → Segmentation and 

Classification → Create Accuracy Assessment Points  

• Analysis → tool → Toolboxes → Spatial Analysis Tools → Segmentation and 

Classification → Compute Confusion Matrix 

Figura 7. 

Herramientas Create Accuracy Assessment Points Y Compute Confusion Matrix 
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Fase 2. Implementación De La Metodología Corine Land Cover Adaptada Para 

Colombia En El Parque Municipal Natural Para Los Periodos 2000, 2017 Y 

2023. 

 

En esta fase se homogenizó las coberturas existentes identificadas en el parque y se 

adaptaron a la metodología Corine Land Cover (MCLC) establecida para Colombia por el 

Instituto de Hidrología, Meteorología y Estudios Ambientales de Colombia (IDEAM). La 

metodología usa una leyenda jerárquica con categorías que permiten agregar datos a nivel 

nacional, o desagregarlo para trabajar en áreas específicas a diferentes escalas menores a 

1:100.000 (IDEAM, 2010). Para el desarrollo de esta investigación se usó la leyenda hasta un 

tercer nivel, coherente con la escala del área de estudio 1:35.000. 

 

Actividad 1. Adaptación De La Leyenda De La MCLC. Una vez identificada la 

leyenda según la MCLC para adaptarlas a las coberturas vegetales identificadas en la fase 

anterior, se homogenizaron las muestras de entrenamiento para generar nuevas firmas espectrales 

y a su vez realizar la clasificación supervisada con la leyenda adaptada a la MCLC. De igual 

manera se aplicó el filtro mayoría para corregir los errores de ruido del efecto sal y pimienta y 

obtener una mejor visualización de los resultados. 

Con la implementación de la herramienta “Zonal geometry As Table” se realiza el 

cálculo de las áreas de las coberturas vegetales existentes. Cabe resaltar que con el uso de esta 

herramienta no se hace necesario convertir los ráster clasificados a vector para realizar los 



 

cálculos mencionados. Seguidamente se realizaron las estadísticas para obtener una mejor 

interpretación, a continuación de nombra la ruta de acceso. 

• Analysis → tool → Toolboxes → Spatial Analysis Tools → Zonal → Zonal 

Geometry Table 

Figura 8.  

Herramienta Para Calcular El Área De Las Coberturas Vegetales 

 

 

Actividad 2. Control De Calidad, Evaluación Y Validación De La Clasificación 

Supervisada. De la misma manera que se realizó en la fase anterior, se realizó el control de 

calidad y verificación de la clasificación supervisada con la leyenda adaptada a la MCLC. 
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Fase 3. Evaluación Del Cambio En Las Coberturas Vegetales Y Su Impacto En 

El Parque Municipal Natural Para Los Periodos 2000, 2017 Y 2023. 

 

En esta fase, se realizó la evaluación de la dinámica de ampliación de la frontera agrícola 

en el área de estudio identificando los cambios de las coberturas en los periodos establecidos. En 

la Figura 8 se visualiza la herramienta utilizada para detectar cambios en las coberturas. 

 

Actividad 1. Identificación De Los Cambios De Coberturas. La identificación de 

cambios en el área de estudio en los diferentes periodos se realizó primeramente a nivel visual a 

través de una salida grafica generada por la herramienta “Compute Change Ráster”, en la cual se 

pudo omitir las clases de las nubes y sombras, ya que son factores no relevantes en el análisis 

multitemporal, a continuación, se nombra la ruta de acceso. 

• Analysis → tool → Toolboxes → Image analyst Tools → Change Detection → 

Compute Change Raster  

Figura 9.  

Herramienta Para Detector Cambios En Las Coberturas Vegetales 

 



 





 

Resultados  

 

Identificación De Las Coberturas Vegetales Existentes 

 

Recolección Y Análisis De La Información  

 

Se recolectó información tal como el plan básico de ordenamiento territorial del 

municipio de Acevedo-PBOT con la alcaldía municipal, el acuerdo 01 de 2005 declaratoria del 

PNM e información cartográfica del PNM con la Corporación Autónoma Regional Del Alto 

Magdalena-CAM, en dicha información se obtuvo el polígono que delimita el PNM ya que es 

uno de los insumos principales del presente estudio. Se recolectó, además, todo tipo de 

información bibliográfica referente a Sistemas de Información Geográfica, Teledetección y la 

Metodología Corine Land Cover-MCLC adaptada para Colombia.   

 
 

Definición Área De Estudio 

 

Con el polígono que delimita el área del PNM La Correntosa se creó un área de influencia 

de 500 metros que se define como el área de estudio del presente proyecto como se observa en la 

figura 10. Dicho polígono tiene unas coordenadas planas de Origen Nacional CTM12, 

coordenada a la izquierda 4.680.589 m; a la derecha 4.685.037 m; arriba 1.753.682 m y abajo 
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1.748.370 m. Es de resaltar que, el área de estudió abarcó 1.242 hectáreas, donde 589 hectáreas 

pertenecen al PNM y 653 hectáreas a el área de influencia.  

Figura 10.  

 

Polígono área de estudio. 

 

 

 
 

 

Las zonas de influencia de las áreas naturales protegidas son de gran importancia, ya que 

estas zonas experimentan cambios asociados a las intensas actividades relacionadas 

primordialmente con el sector primario, la industria y los servicios, lo que propicia que dentro y 

fuera de las áreas protegidas se generen problemas ambientales, como incendios forestales, 

deforestación, problemas de azolvamiento y pérdida de la cubierta superficial del suelo, entre 

otros, y que interrumpen la conectividad de los ecosistemas y su biodiversidad (Domínguez 

Cervantes, 2009).  
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Búsqueda y Descarga De Imágenes Satelitales  

 

Se seleccionaron y descargaron las imágenes de la temporalidad 2000, 2017 y 2023 de 

diferentes satélites y por ende, sensores y resoluciones, debido a que el área de estudio 

permanentemente cuenta con mucha nubosidad no fue posible realizar el estudio bajo la misma 

resolución para las tres imágenes, sin embargo, para la clasificación de las coberturas es 

importante la resolución espectral y los tres sensores en sus bandas RGB y NIR tienen los rangos 

espectrales con diferencia mínima, por lo que no se hace necesario interpolar, de igual manera, la 

resolución espectral define el nivel de la metodología Corine Land Cover a trabajar. En la tabla 6 

se registra las tres imágenes descargadas con su temporalidad e información importante para 

realizar el procesamiento de estas, como lo es el tipo de sensor y las resoluciones espectral, 

espacial, radiométrica y temporal. 

Tabla 6. 

Imágenes Descargadas  

 

Año  Referencia Satélite 

y 

sensor 

Resolución espectral 

 y espacial 

Resolución 

radiométric

a y temporal  

2000 "LE07_L2

SP_008059

_20000830

_20200917

_02_T1" 

Landsat 

7 

Sensor  

enhance

dThema

ticPlus 

ETM+  

Banda 1 visible Azul (0.45 – 0.52 µm)-30m 

Banda 2 visible Verde (0.53 – 0.61 µm) -30m 

Banda 3 visible Roja (0.63 – 0.69 µm) -30m 

Banda 4 Infrarrojo cercano (0.78 – 0.90 µm) -60m  

Banda 5 Infrarrojos onda corta (1.55-1.75µm)-

60m 

Banda 6 Infrarrojo térmica (10.4 – 12.5 µm) -60m  

Banda 7 Infrarrojo medio (2.08 – 2.35 µm)-60m 

Banda 8 Pancromático (0.52 – 0.90 µm) -15m 

16 bits 

 

16 días 

2017 "20170920

_161941_1

048_3B_A

Planet-

SuperD

ove 

Banda 1: Azul costero (0.43 – 0.45 µm) – 3m 

Banda 2: Azul: (0.46 – 0.51 µm) – 3m 

Banda 3: Verde I: (0.51 – 0.54 µm) – 3m  

Banda 4: Verde: (0.54 – 0.58 µm) – 3m 

12 bits 

 

1 día 
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nalyticMS_

SR" 

PSB.SD 

 
Banda 5: Amarillo: (0.60 - 0.62 µm) – 3m 

Banda 6 :Rojo: (0.65 – 0.68 nm) – 3m 

Banda 7: Borde rojo: (0.69 – 0.71 µm) – 3m 

Bando 8: NIR: (0.84 – 0.88 µm) – 3m 

2023 “S2B_MSI

L2A_2023

0826T1526

39_N0509

_R025_T1

8NVG_202

30826T205

820.SAFE” 

Sentinel 

2 

Sensor 

Multispe

ctral 

Instrume

nt (MSI) 

 

Banda 1: Aerosol (0.43- 0.45 μm) – 60 m 

Banda 2: Blue (0.45- 0.52 μm) – 10 m 

Banda 3: Green (0.54-0.57 μm) - 10 m 

Banda 4: Red (0.65-0.68 μm) - 10 m 

Banda 5: Red Edge 1 (0.69-0.71 μm) - 20 m 

Banda 6: Red Edge 2 (0.73-0.74 μm) - 20 m 

Banda 7: Red Edge 3 (0.77-0.79 μm) - 20 m 

Banda 8: NIR 1 (0.78-0.90 μm) - 10 m 

Banda 8A: NIR 2 (0.85-0.87 μm) - 20 m 

Band 9: Water Vapour(0.93-0.95μm)-60 m 

Banda 10: Cirrus (1.36-1.39 μm) - 60 m 

Banda 11: Swir 1 (1.56-1.65 μm) - 20 m 

Banda 12: Swir 2 (2.10-2.28 μm) - 20 m 

12-16 bits 

 

5-10  días 

 

 

Procesamiento Digital De Las Imágenes Satelitales   

 

 

El procesamiento digital de las imágenes satelitales se realizó con la herramienta SIG 

ArcGIS Pro, ya que es un software que proporciona las herramientas avanzadas para el análisis 

espacial multivariado y detección de cambios. 

 

Reproyección De Coordenadas Y Recorte Área De Estudio. Se reproyectó las 

imágenes satelitales hacia el sistema de coordenadas planas Colombia, magna sirgas origen 

nacional CMT 12, en la Figura 11 se visualiza la creación de sistema CTM 12 en el software, ya 

que no lo trae incorporado. 

Figura 11. 
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Creación Sistema De Coordenadas Origen Nacional CTM 12 

 

En la figura 12 se observa las imágenes multiespectrales en color natural con el recorte 

del área de estudio y delimitando el área del PNM, de izquierda a derecha se ubica la imagen del 

año 2000, 2017 y 2023.  

Figura 12. 

Recorte de Las Imágenes Multiespectrales 
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Realce De Las Imágenes. Las imágenes multiespectrales descargadas ya en niveles de 

reflectancia de la superficie se componen de las cuatro bandas con la mejor resolución, bajo este 

criterio la imagen landsat 7 del año 2000 quedó con una resolución de 30 metros, la imagen 

Planet del año 2017 quedó con una resolución de 3 metros y la imagen sentinel 2 quedó con una 

resolución de 10 metros. Sin embargo, debido a la densidad de la cobertura boscosa se realizaron 

diferentes realces como combinación de bandas en color natural y falso color, análisis de 

componentes principales y el índice de vegetación diferenciada mejorada, con los cuales se logró 

tener más detalle e identificar coberturas diferentes al bosque denso. 

 

Combinación De Banda. La figura anterior se visualiza en la combinación a color 

natural, a simple vista se observa la diferencia de brillo y resolución en las tres imágenes, sin 

embargo, se logra identificar coberturas como bosque denso, pastos, suelos desnudos, dos casas 

en la imagen del 2023 y la quebrada La Tijiña en la imagen del 2017 que se confunde con una 

vía rural.  

La combinación en falso color de infrarrojos permitió identificar y confirmar las 

coberturas observadas en la combinación a color natural, sin embargo, por sus tonalidades rojas 

oscuras se destaca más el bosque denso y las tonalidades en rojo claro a rosado se destaca más 

los pastos, En la figura 13 se observa la combinación en infrarrojo. 

Figura 13. 

Combinación en falso color Infrarrojos  
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Análisis De Principales Componentes. En la figura 14 se logra visualizar los principales 

componentes de cada imagen, con este realce se define más las coberturas y el detalle de las 

mismas, por lo que se confirma las coberturas identificadas con los realces anteriores y se 

identifica otras coberturas como lo son los cuerpos de agua como La Quebrada La Tijiña y 

algunos de sus afluentes, y deslizamientos que se confunden con suelo desnudo. 

Figura 14. 

Análisis De Componentes Principales  
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Índice De Vegetación De Diferencia Normalizada. El índice NVDI para las tres 

imágenes tienen diferentes rangos en los valores, esto puede ser por el diferente tamaño de pixel 

de cada imagen. Para la imagen del año 2000 arrojó valores entre 0.1 a 0.5,  para la imagen del 

2017 entre 0.09 a 0.8 y para la imagen del año 2023 entre el 0.1 a 0.6. Lo cual confirma las 

coberturas vegetales ya identificadas con los realces anteriores. En la imagen del 2017 el indice 

indica coberturas con vegetación muy densa, seguido del año 2023 y en la imagen del 2000 

indica menos vegetación densa. Los valores cercanos a 0 y 0.1 en las tres imágenes indican las 

nubes, sombras y cuerpos de agua. En la Figura 15 se observa los índices NDVI de las tres 

temporalidades.  

Figura 15. 

Índice De Vegetación De Diferencia Normalizada 

 

 

Clasificación No Supervisada. La clasificación no supervisada se realizó con seis clases 

en cada temporalidad, ésta permitió tener más claridad de las coberturas ya identificadas debido 

a que clasifica las coberturas por sus niveles de reflectancia, en la clase uno se identifica las 
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sombras de las nubes y de la vegetación densa que marca el cauce de los cuerpos de agua, la 

clase dos se identifica la vegetación densa, la clase tres como la vegetación con menos densidad, 

la clase cuatro vegetación sin densidad, la clase cinco como pastos y la clase seis como los suelos 

desnudos las dos casas identificadas y las nubes.  En la figura 16 se visualiza la clasificación no 

supervisada, arrojada por el software.   

Figura 16.  

Clasificación NO Supervisada 

 

 

Clasificación Supervisada. Con las coberturas vegetales existentes ya identificadas 

gracias a los realces y la clasificación no supervisada se definió las siguientes clases: Sombras, 

Bosque Denso, Bosque, Pastos, Quebradas, Suelos Desnudos, Casas y Nubes, cabe resaltar que 

para la imagen del año 2000 no se identificó la clase Quebradas debido a la resolución y a que la 

densidad de los bosques tapa los cuerpos de agua, y no se identificó la clase Casas debido a que 

en esa temporalidad no existían.  
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Muestras De Entrenamiento Y Firmas Espectrales. Se realizó las muestras de 

entrenamiento o semilleo de las ocho clases definidas, usando los diferentes realces y la 

clasificación no supervisada como guía para el semilleo, en la figura 17 se observa el ejemplo del 

semilleo para la clase Nubes del año 2000 usando los realces, en la figura 18 se observa el 

semilleo de todas la clases en las tres imágenes y en la figura 19 se observa la firma espectral 

generada en este caso para la clase Nubes del año 2000, donde se evidencia su pico de 

reflectancia en la banda 4 o de  Infrarrojo cercano con longitudes de onda entre 0.78 – 0.90 µm. 

Figura 17. 

Muestras De Entrenamiento Usando Los Diferentes Realces 

 

 

Figura 18. 

Muestras de Entrenamiento De Las Temporalidades 2000, 2017 y 2023 
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Figura 19. 

Firma espectral 

 

 

 Máxima Verosimilitud Y Filtro Mayoría. Con el método máxima verosimilitud de la 

clasificación supervisada y el filtro mayoría aplicado, se identificaron las coberturas vegetales 

existentes en el PNM La Correntosa para las tres temporalidades, se encontró que, la cobertura 

de Bosque Denso disminuyó por la cobertura Bosque del año 2000 a 2017, sin embargo, para el 

año 2023 aumenta la cobertura Bosque Denso nuevamente. La cobertura Pasto aumentó del año 
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2000 a 2017 disminuyendo la cobertura Bosque, sin embargo, para el año 2023 disminuyó la 

cobertura Pasto recuperándose la cobertura Bosque. El mismo comportamiento presenta la 

cobertura suelos desnudos, donde aumentó del año 2000 a 2017 disminuyendo la cobertura 

Pastos y para el año 2023 disminuye la cobertura Suelos Desnudos y aumenta la cobertura Pastos 

y Bosque.  

Las coberturas Quebradas y Casas del año 2017 al 2023 se mantienen. Cabe resaltar que 

las coberturas Nubes y Sombras se clasifican porque ocupan área sobre las coberturas, pero se 

convierten en coberturas sin información, por lo tanto, son factores no relevantes en el análisis 

multitemporal y la detección de cambios. En la figura 20 y en el anexo I se observa la salida 

gráfica de la clasificación supervisada de las coberturas vegetales existentes del PNM la 

correntosa con el filtro mayoría aplicado. 

Figura 20. 

Clasificación Supervisada De Las Coberturas Vegetales Existentes  
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Control De Calidad. Comparando las coberturas vegetales existentes arrojadas por la 

clasificación supervisada y las que se observan en las imágenes multiespectrales a color natural, 

se observa que la mayoría de las coberturas coinciden, lo cual indica una clasificación de calidad.  

En el año 2000 las coberturas nubes, sombras, pastos, Bosque y Bosque Denso coinciden 

exactamente, sin embargo, los suelos desnudos no coinciden en el área donde están las nubes, ya 

que pixeles de las nubes fueron tomados como suelos desnudos por sus niveles de reflectancia. 

En la figura 21 se puede observar la comparación entre los dos ráster de esta temporalidad. 

Figura 21. 

Control De Calidad De La Clasificación Supervisada Año 2000  

 

En el año 2017 y 2023 las coberturas Nubes, Sombras, Pastos, Bosque y Bosque Denso 

coinciden exactamente, sin embargo, en la imagen del 2017 al igual que el año 2000 los Suelos 

Desnudos, Quebradas y Casas no coinciden en el área donde están las nubes, y en la imagen del 

2023 no coincide algunas zonas de la cobertura Quebradas, se confunde con zonas de bosque 

denso, esto debido a que estas dos coberturas son las que tienen menor nivel de reflectancia. En 

la figura 22 se puede observar la comparación entre los dos ráster de la temporalidad 2017 y 

2023. 
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Figura 22. 

Control De Calidad De La Clasificación Supervisada Año 2017 y 2023 

   

 

Evaluación Y Verificación De La Clasificación Supervisada. En la figura 23 se 

observa los puntos de evaluación y la verificación de la clasificación supervisada del año 2000 

mediante la matriz de confusión. La matriz arroja un índice kappa de 0.9 lo cual indica una casi 

perfecta concordancia entre las coberturas y los puntos de evaluación, pues la clase seis  

(cobertura de suelos desnudos) no tuvo gran coincidencia como ya se había observado en la 

figura de control de calidad de esta temporalidad. 

Figura 23  

Puntos De Evaluación y Matriz De Confusión año 2000 
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En la figura 24 y 25 se observa los puntos de evaluación y la verificación de la 

clasificación supervisada del año 2017 y 2023 mediante la matriz de confusión. La matriz arroja 

un índice kappa de 0.7 en ambas clasificaciones, lo cual indica según la valoración del 

coeficiente una considerable concordancia entre las coberturas y los puntos de evaluación, sin 

embargo, es de resaltar que en la clase cinco (cobertura de quebradas) hubo una mínima 

coincidencia como ya se había observado en el control de calidad y en la clase siete (casas) no 

hubo coincidencia alguna, esto debido a que, se identificaron solo 2 casas lo cual son áreas muy 

mínimas que se alcanzaron a clasificar pero no son relevantes. 

Figura 24 

Puntos De Evaluación y Matriz De Confusión año 2017 
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Figura 25 

Puntos De Evaluación y Matriz De Confusión año 2024 

 

 

Implementación De La Metodología Corine Land Cover  

 

Con las coberturas vegetales existentes ya identificadas y clasificadas se logró agruparlas 

según la leyenda jerárquica con categorías de la Metodología Corine land Cover (MCLC) 

adaptada para Colombia. Las coberturas de Suelos Desnudos, Pastos, Casas y Quebradas se 

identificaron en la categoría de nivel 3 que representa una cobertura de Mosaico de Cultivos, 

Pastos y Espacios naturales, según la leyenda de la MCLC en el nivel 2 se identifican como áreas 

agrícolas heterogenias y en nivel 1 como territorios agrícolas. De igual manera, las coberturas 

identificadas como Bosque Denso Y Bosque se agruparon como Bosque Denso según la 

categoría nivel 3 de la leyenda de la MCLC. En la tabla 7 se visualiza de una manera organizada 

las coberturas identificadas en la MCLC y su leyenda jerárquica en cada categoría. 
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Tabla 7. 

Coberturas Identificadas y Su Leyenda Según La Metodología Corine Land Cover 

CATEGORIAS  NIVEL 1 NIVEL 2 NIVEL 3 

Cobertura I 2. Territorios 

Agrícolas 

2.1 Áreas Agrícolas 

Heterogéneas  

2.1.4 Mosaico de 

Cultivos, Pastos y 

Espacios Naturales 

Cobertura II 3. Bosques y Áreas 

Semi Naturales 

3.1 Bosques  3.1.1 Bosque Denso 

 

Adaptación De La Leyenda De La Metodología Corine Land Cover 

 

Las coberturas vegetales existentes con la leyenda adaptada de la MCLC, se clasifican 

nuevamente con las sombras y nubes, por ende las clases definidas para realizar la clasificación 

supervisada son: Sombras, Bosque Denso, Mosaico De Cultivos, Pastos Y Espacios Naturales 

(Mosaico CPN), y Nubes. Las muestras de entrenamiento se agruparon según esta nueva leyenda 

y se generaron nuevas firmas con las cuales se reclasificó las tres temporalidades. En anexo II y 

en la figura 26 se observa la salida gráfica de la clasificación supervisada según la leyenda de la 

MCLC para las tres temporalidades y en la tabla 6 se observan las áreas en hectáreas (has) de las 

coberturas vegetales en las diferentes temporalidades. 

Figura 26 

Clasificación Supervisada Con La leyenda CLC 
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Se observa que el año 2000 la Cobertura de Mosaico CPN se concentra al Centro-oeste y 

Noroeste del parque y su área de influencia, para el año 2027 se expande por todo el parque en 

especial al suroeste y centro-este del parque y su área de influencia. Sin embargo, para el año 

2023 se reduce en gran medida la cobertura de Mosaico CPN dispersa en todo el parque. Es de 

resaltar que del año 2000 a 2023 el Mosaico CPN aumentó en el centro-oeste y sur-oeste del 

parque y su área de influencia. 

Tabla 8. 

Área De Las Coberturas En Las Tres Temporalidades 

COBERTURA AREA 2000 has AREA 2017 has AREA 2023 has 

2 Bosque Denso 1.091 1.008 1.142 

3 Mosaico CPN 72 177 90 

4 Otros 79 57 10 

TOTAL 1.242 1.242 1.242 
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En la figura 27 se observa que para el año 2000 la cobertura Bosque Denso representa el 

88% de las coberturas con 1.091 has. La cobertura Mosaico CPN el 6% con un área de 72 has y 

el otro 6% representa otras coberturas que no aportan información a la investigación con un área 

de 79 has. 

Figura 27. 

Porcentaje De Coberturas vegetales en el año 2000 

 

En la figura 28 se observa que para el año 2017 el Bosque Denso representa el 85% de las 

coberturas con un área de 1.008 has, la cobertura de Mosaico CPN el 10% con un área de 177 has, 

y el 5% representa otras coberturas que no se tienen en cuenta en el análisis multitemporal con un 

área de 57 has.  

Figura 28. 

Porcentaje De Coberturas vegetales en el año 2017 
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En la figura 29 se observa que en el año 2023 la cobertura de Bosque Denso representa el 

92% de la cobertura vegetal con un área de 1.142 has, la cobertura Mosaico CPN el 7% con un 

área de 90 has, y el 1% representa a las coberturas que no tienen información para la presente 

investigación, con un área de 10 has. 

Figura 29. 

Porcentaje De Coberturas vegetales en el año 2023 

 

 

Control De Calidad, Evaluación Y Validación De La Clasificación Supervisada 

Adaptada  

 

Se realizó una clasificación supervisada de calidad ya que las coberturas coinciden con 

las coberturas identificadas en la imagen multiespectrales a color natural. En el año 2000 las 

cobertura Nubes, Sombras, Mosaico CPN y Bosque Denso coinciden exactamente, sin embargo, 

áreas de la cobertura Mosaico CPN no coinciden en el área donde están las nubes, esto vuelve a 

ocurrir al igual que en la fase 1, por lo tanto, se puede establecer que a simple vista por la 

resolución de la imagen no se identifica que haya esta cobertura, pero las clasificaciones no 

supervisada, supervisada y los realces como el PCA indican que hay una cobertura de Mosaico 

92%

7%1%

PORCENTAJE DE COBERTURAS AÑO 

2023

Bosque Denso

Mosaico

Otros
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en la zona de discusión. En la figura 30 se puede observar la comparación entre los dos ráster 

mencionados de esta temporalidad. 

Figura 30. 

Control De Calidad De La Clasificación Supervisada Adaptada Año 2000  

 

En el año 2017 y 2023 las cobertura Nubes, Sombras, Mosaico CPN y Bosque Denso 

coinciden exactamente, sin embargo, en la imagen del 2017 al igual que el año 2000 áreas de la 

cobertura Mosaico CPN no coinciden en el área donde están las nubes, aunque la imagen tiene 

buena resolución, el opaco brillo de la misma no permite identificar esta cobertura en esa zona, 

sin embargo, las clasificaciones no supervisada, supervisada y los realces como el PCA indican 

que si hay una cobertura de Mosaico CPN en la zona de las nubes, pero pequeña a comparación 

de lo que arroja la clasificación en discusión. En la figura 31 se puede observar la comparación 

entre los dos ráster mencionados de la temporalidad 2017 y 2023. 

Figura 31. 

Control De Calidad De La Clasificación Supervisada Adaptada Año 2017 y 2023 
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En la figura 32, 33 y 34 se observa los puntos de evaluación y la verificación de la 

clasificación supervisada adaptada a la MCLC para las tres temporalidades mediante la matriz de 

confusión. Para el año 2000 y 2023 la matriz arroja un índice kappa de 1 y para el año 2017 un 

índice de 0.9 lo cual indica una casi perfecta concordancia entre las coberturas y los puntos de 

evaluación de las tres temporalidades. 

Figura 32. 

Puntos De Evaluación y Matriz De Confusión, Clasificación Supervisada Adaptada Año 2000 

 

Figura 33. 

Puntos De Evaluación y Matriz De Confusión, Clasificación Supervisada Adaptada Año 2017 
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Figura 34. 

Puntos De Evaluación y Matriz De Confusión, Clasificación Supervisada Adaptada Año 2023 

 

 

Evaluación Del Cambio De Las Coberturas Vegetales 

 

Se determina la ampliación de la frontera agrícola, según los cambios de las coberturas 

vegetales encontrados en el PNM La Correntosa y su área de influencia en los periodos 2000-

2017, 2017-2023 y 2000-2023.  



74 Análisis multitemporal de la expansión de la frontera agrícola en el PNM La Correntosa  

 

Para la interpretación de la dinámica de los cambios de coberturas, se entiende que, sin 

cambio hace referencia a las coberturas que ha permanecido con la misma cobertura o no han 

sufrido cambio. Recuperación hace referencia al cambio de cobertura Mosaico CPN a Bosque 

Denso y Ampliación de la frontera agrícola hace referencia al cambio de la cobertura Bosque 

Denso a Mosaico CPN. 

 

Identificación De Los Cambios De Cobertura Vegetal 

 

Los cambios de coberturas para los tres periodos establecidos se observan en la salida 

gráfica del anexo IV y en la figura 35. En la tabla 7 se observa el área en has de los cambios de 

las coberturas en cada periodo. 

Figura 35. 

Cambios De Coberturas Vegetales En Los Periodos 2000-2017, 2017-2023 Y 2000-2023.  
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Tabla 9. 

Áreas De Los Cambios De Las Coberturas Vegetales En Los Tres Periodos 

ID CAMBIOS 
AREA has 

2000-2017 

AREA has 

2017-2023 

AREA has 

2000-2023 

1 Bosque Denso a 

Mosaico CPN 

109 28 56 

2 Mosaico CPN a 

Bosque Denso 

25 116 40 

3 
Otros 

109 69 89 

4 Sin Cambios 998 1.028 1.046 

TOTAL 1.241 1.241 1.231 

 

Periodo 2000-2017. En este periodo se mantuvo en gran magnitud las coberturas 

vegetales existente, sin embargo, se identifica el cambio de la cobertura Bosque Denso a 

Mosaico CPN lo cual se interpreta como la ampliación de la frontera agrícola, este cambio se 

observa en pequeñas áreas distribuidas en todo el parque y su área de influencia. Se identifica de 

igual manera, en menor magnitud la recuperación natural o antrópica del Bosque Denso con el 

cambio de la cobertura Mosaico CPN a Bosque Denso.  

En la figura 36 se observa que el 10 % de las coberturas tuvo un cambio de Bosque 

Denso a Mosaico CPN, equivalente a un área de 109 has de ampliación de la frontera agrícola. 

Se observa también, que el 2% de las coberturas tuvo un cambio de Mosaico CPN a Bosque 

Denso, equivalente a un área de 25 has de recuperación del Bosque Denso. Y el 88% de la 

cobertura del parque y su área de influencia no presentó cambios, lo equivalente a un área de 998 

has. 

Figura 36. 
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Porcentaje De Cambio Coberturas Vegetales Periodo 2000-2017 

 

 

Periodo 2017-2023. En este periodo se recupera de manera significativa la cobertura de 

Bosque Denso debido al cambio de la cobertura Mosaico CPN a Bosque Denso, este cambio se 

observa en áreas distribuidas en todo el parque y el área de influencia, específicamente sobre el 

centro-este del área de influencia. También se identifica en menor magnitud el cambio de la 

cobertura Bosque Denso a Mosaico CPN que se interpreta como ampliación de la frontera 

agrícola, dicho fenómeno se observa en el centro y suroeste del parque, y en el centro-oeste y 

noroeste del área de influencia. 

En la figura 37 se observa que el 2% de la cobertura cambió de Bosque Denso a Mosaico 

CPN, equivalente a un área de 28 has de ampliación de la frontera agrícola. El 10% cambió de 

Mosaico CPN a Bosque Denso, equivalente a un área de 116 has que se recuperaron natural o 

antrópicamente. Y el 88% de las coberturas del parque y su área de influencia no presentó 

cambios, lo equivalente a un área de 1.028 has.  

Figura 37. 

Porcentaje De Cambio Coberturas Vegetales Periodo 2017-2023 
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Unidos los dos periodos anteriores en el periodo 2000 a 2023, se identifica en gran 

magnitud que las coberturas vegetales existentes se mantuvieron sin presentar cambios, sin 

embargo, se identifica la ampliación de la frontera agrícola al suroeste, centro-oeste y noroeste, 

del parque y de la zona de influencia. Es de resaltar, aunque en menor representación la 

recuperación del Bosque Denso al noroeste, centro-oeste y centro-este de la zona de influencia, 

así como al noroeste y centro-oeste del parque.  

En la figura 38 se observa que el 5% de la cobertura cambió de Bosque Denso a Mosaico 

CPN, equivalente a un de área de 56 has de la ampliación de la frontera agrícola, el 3% de 

Mosaico CPN a Bosque Denso, equivalente a un área de 40 has de recuperación del bosque 

denso y el 92% de la cobertura equivalente a 1.046 has no presentó cambios. 

Figura 38. 

Porcentaje De Cambio Coberturas vegetales en el año 2000 a 2023 
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Discusión 

 

La cobertura vegetal más representativa del PNM La Correntosa y su área de influencia 

es la cobertura de Bosque Denso, sin embargo, del periodo 2000-2017 el bosque sufrió una 

pérdida de 83 hectáreas. Debido a la falta de política y control ambiental para la conservación 

sobre el área protegida y su influencia en este periodo.  En dicha perdida y falta de control, tomó 

terreno la ampliación de la frontera agrícola, cuyas actividades agropecuarias como el cultivo de 

café y ganadería, además del aprovechamiento ilícito de especies nativas maderables no son 

vigiladas en las zonas de mayor altura y de Bosque Denso. Según PBOT (2016) el municipio de 

Acevedo se caracteriza por su cobertura abundante de cultivos de café, gracias a sus alturas 

adecuadas para la siembre de este cultivo, además de pastos y entre otros. 

 

La cobertura de Bosque Denso en el periodo 2017-2023 tuvo una recuperación significa 

de 142 hectáreas, debido a que en el año 2015 las entidades gubernamentales encargadas del 

PNM realizaron la compra de predios de uso agrícola en el área de influencia del PNM para la 

conservación y protección del mismo. Sin embargo, es de resaltar que la importancia ecológica 

del parque es vital para la comunidad del municipio de Acevedo, puesto que, del parque yace la 

fuente abastecedora de agua potable para el casco urbano del municipio. Por ende, las medidas 

de protección deben de seguir implementándose ya que aún existe en el parque y en su área de 

influencia 90 hectáreas de Mosaico de Cultivos, Pastos y Espacios Naturales que según la 

metodología corine land cover los categoriza como territorios agrícolas.  
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La cobertura Mosaico CPN en el área del PNM y en su área de influencia tuvo un 

crecimiento importante en el trascurso de 23 años. En el año 2000 se evidencia esta cobertura 

solo en el noroeste y centro-oeste del área de influencia y en el año 2023 se expande y se 

evidencia al suroeste de la misma. Las áreas de influencia no son áreas protegidas, pero incluyen 

paisajes con características naturales similares a las áreas protegidas. Por ende, sirve como zona 

de transición para mitigar los efectos adversos que pudieran tener sobre la zona protegida las 

modificaciones ambientales de su entorno (Valdés Perezgasga, 2014). 

 

Los territorios agrícolas de las veredas Recreo, San José de Las Minas, San Jose de 

Llanitos y Bolivar se expanden cada vez hacia el PNM y su área de influencia. En la vereda el 

Recreo limitante al noroeste del parque se ha mantenido el territorio agrícola sobre un área 

pequeña del parque, y se ha expandido en el área de influencia. En las veredas san José de las 

Minas y San José de Llanitos limitantes por el centro-oeste del parque, se ha expandido los 

territorios agrícolas tanto en el área de influencia como en el parque. Y en la vereda Bolivar 

limitante por el suroeste del parque, se evidencia que no había territorios agrícolas en el año 

2000 cerca al parque y su área de influencia, y para el año 2023 se expandió el territorio agrícola 

considerablemente tanto en el PNM como su área de influencia.  

 

La dinámica de las dos coberturas del PNM y su área de influencia respecto a las tres 

temporalidades analizadas, se observa en la figura 38. Donde se evidencia que la cobertura 

Bosque denso predomina en las tres temporalidades, sin embargo, en el año 2017 su área 

disminuye recuperándose nuevamente en el año 2023, y de igual manera se evidencia el 
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comportamiento de la Cobertura Mosaico CPN, donde presenta un crecimiento en el año 2017 y 

disminuye nuevamente en el año 2023. 

Figura 39. 

Dinámicas De Las Coberturas En Las Tres Temporalidades 

 

 

 

Es de resaltar que debido a las abundantes lluvias en el parque se identificó la ocurrencia 

de fenómenos naturales como erosión y remoción en masa lo que genera deslizamientos, cerca 

de los afluentes hídricos que yacen y hacen parte del parque. Sin embargo, por la resolución de 

las imágenes, estos se clasificaron inicialmente como suelos desnudos y con la adaptación a la 

leyenda de la MCLC se agrupó como Mosaico CPN. Dicho fenómeno se ubica disperso en toda 

el área del PNM y área de influencia, se observa en mayor detalle en la imagen de la mayor 

resolución (Planet scope), por ende, hubo mayor cobertura de Mosaico CPN para el año 2017.  
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Conclusiones 

 

Se logró identificar las coberturas vegetales existentes en el Parque Natural Municipal 

(PNM) La Correntosa y su área de influencia atreves de la clasificación supervisada, donde se 

encontró coberturas de Bosque Denso, Bosque, Pastos, Quebradas, Suelos Desnudos y Casas en 

las tres temporalidades (2000, 2017, 2023). 

 

Con la implementación de la metodología Corine Land Cover adaptada para Colombia en 

las coberturas vegetales existentes del PNM la Correntosa y su área de influencia, se logró 

identificar las coberturas Bosque Denso Y Mosaico de Cultivos, Pastos y Espacios Naturales 

(CPN) en las tres temporalidades. Donde el Bosque Denso en la actualidad (2023) tiene un área 

de 1.142 hectáreas y el Mosaico CPN tiene un área de 90 hectáreas.  

 

Se evaluó el cambio en las coberturas vegetales existentes gracias a la herramienta 

“compute change ráster” del software SIG ArcGIS Pro, donde se establece que durante el 

periodo 2000-2023 la cobertura Bosque Denso tuvo un cambio de 56 hectáreas a Mosaico CPN, 

y la cobertura Mosaico CPN cambió 40 hectáreas a Bosque Denso. 

 

Atreves del análisis multitemporal se analizó que la frontera agrícola en el Parque Natural 

Municipal La Correntosa y su área de influencia, presenta una expansión de alerta, pues en el año 

2000 se encontró 72 hectáreas de territorios agrícolas y en 2023 incrementó a 90 hectáreas.  
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Se evidencia que para el periodo 2017-2023 la expansión de la frontera agrícola tuvo una 

disminución significativa de 87 hectáreas debido a la compra de predios por parte de las 

entidades gubernamentales encargadas del PNM, en el cual el Bosque Denso se recuperó. Sin 

embargo, se debe seguir implementando medidas de conservación para proteger el PNM, ya que 

la cobertura de Mosaico CPN del área de influencia se ha expandido sobre el PNM. 

 

Con la ampliación de la frontera agrícola en las coberturas de Bosque Denso del PNM y 

su área de influencia causa desplazamiento de especies por la tala de bosques, quema de carbón y 

asentamientos humanos, y pone en riesgo la calidad del recurso hídrico por el uso de 

agroquímicos y pesticidas en los cultivos y por coliformes fecales generados por la ganadería, los 

cuales llegan indirectamente a los causes de las quebradas que alimentan el cauce principal del 

acueducto del municipio de Acevedo.  

 





 

Recomendaciones 

 

Es necesario que se tomen medidas urgentes y pertinentes sobre las veredas limitantes del 

PNM La Correntosa, en especial en la vereda Bolívar, ya que en el análisis multitemporal se 

identifica el avance de la frontera agrícola del área de influencia hacia el área del PNM. 

 

Según el plan básico de ordenamiento territorial del municipio de Acevedo, se proyectó 

predios cercanos al PNM para la conservación y protección de los recursos naturales, por lo cual, 

se recomienda la compra de estos lo más antes posible, con el fin de detener la ampliación de la 

frontera agrícola y recuperar el Bosque Denso del PNM y su área de influencia meritoria de su 

protección. 

 

Para analizar la ampliación de la frontera agrícola sobre coberturas de Bosque Denso, es 

recomendable el uso de sensores remotos que capture imágenes de alta resolución espacial, 

puesto que fue difícil identificar las coberturas de territorios agrícolas sobre el Bosque Denso con 

imágenes satelitales de baja resolución como es caso de Landsat 7. 

 

Hay pocos estudios que se centren en áreas de bosques densos, donde la baja 

disponibilidad de datos y los procesos de cambio complejos presentan desafíos para el monitoreo 

de los impactos ambientales, por ende, los métodos de detección de cambios temporales se 

requieren de imágenes libres de nubes para un producto de cambio sin brechas, pues la cobertura 
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de nubes presenta una restricción clave, especialmente en los trópicos donde la nubosidad es 

frecuentemente alta.  

 

Es importante que se implemente el análisis espacial de fenómenos naturales como 

remoción en masa del PNM, para tomar medidas de gestión de riesgo, ya que en este estudio 

gracias a las imágenes planet scop y sentinel-2 de alta resolución, se identificó la ocurrencia de 

deslizamientos cerca de los afluentes hídricos que yacen y hacen parte del parque.  

 

Se recomienda el uso de la herramienta de análisis de componentes principales-PCA, 

para dar realce a las coberturas que son difícil de identificar en medio de Bosque denso. De igual 

manera, se recomienda realizar la clasificación No supervisada cuando no se tiene conocimiento 

en campo, con el fin de tener más certeza a la hora de identificar las clases para la clasificación 

supervisada.  

 

Se recomienda el uso de los sensores remotes y los sistemas de información geográfica, 

para conocer la evolución de los ecosistemas y analizar impactos ambientales ocurridos a través 

del tiempo. 
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A. Anexo: Mapa de cobertura vegetal año 2000 

 



 

B. Anexo: Mapa de cobertura vegetal año 2017 
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C. Anexo: Mapa de cobertura vegetal año 2023 
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D. Anexo: Mapa de cambios de cobertura vegetal periodo 

2000-2017 
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E. Anexo: Mapa de cambios de cobertura vegetal periodo 

2017-2023 
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F. Anexo: Mapa de cambios de cobertura vegetal periodo 

2000-2023 

 


